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Preface 

AFROSAI-E has declared performance audit as a strategic imperative and decided on an ambitious 

goal for the development of performance audit within the region. The organisation will achieve this 

by supporting member SAIs with training, production of training material, website development and 

quality assurance visits. 

The International Standards of Supreme Audit Institutions (General standards in Government 

Auditing, ISSAI 200) issued by INTOSAI1 stipulate that each Supreme Audit Institution (SAI) should 

adopt policies and procedures to prepare manuals and other written guidance and instructions 

concerning the conduct of audits. AFROSAI-E has already developed a template manual on 

performance audit that member SAIs may choose to customise to their national context. As a 

continuation of this work, the organisation has decided to develop supplementing guidelines for 

specific audit topics or areas that are often the object for performance audits. This guideline on 

performance audit report writing is fifth in this series of guidelines. The first four focus on 

performance audit of different topics. 

This guideline was developed by a working group consisting of Ms Ingvild Gulbrandsen, Mr Jens-Are 

Enoksen and Mr Jostein Tellnes from our institutional partner, the Office of the Auditor General of 

Norway, in cooperation with Lars Florin from the AFROSAI-E Secretariat. The working group visited 

the SAIs of Namibia to collect the experiences from report writing, where in particular Mr. Alan 

Hansen contributed to the guideline. A draft version of the guidelines was commented on by 

experienced auditors from the SAIs of Namibia and Uganda, as well as by long-terms advisors at the 

SAIs in Sierra Leone and Tanzania.  

I hope the guideline will assist SAIs in further improving performance audit report writing. If you have 

feedback on the guideline or suggestions for new topics in this series of guidelines you are welcome 

to contact Lars Florin, Senior Performance Audit Manager at the AFROSAI-E Secretariat on 

larsf@agsa.co.za. 

 

 

M W Pretorius 

Executive Officer 

AFROSAI-E Secretariat  

  

                                                 
1
 International Organisation of Supreme Audit Institutions 
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1. The importance of report writing in performance audit 

The performance audit report is the most important product of the audit, with the aim to add value 
and better use of resources. It is the product on which the SAI’s performance audit function is judged 
by the stakeholders. Errors in the report could be potentially damaging to the credibility of the 
particular report and to the SAI as an organisation. It is therefore of importance that a great deal of 
attention be given to the accuracy, logic and clarity of a report.2 

Performance audit reports present evidence on performance problems and the roots causes to them, 
as well as conclusions on the performance and usually practical recommendations to the responsible 
party on how to improve performance. To get the message forwarded to the target groups like 
parliament, government and other stakeholders, the report has to be: 

 Reader-friendly; 

 Clear; 

 Concise; 

 Logical; 

 Timely and; and 

 Focused on the topic. 

The whole report has to have a clear message, and findings and conclusions should be based on audit 
evidence and answer the audit questions. Recommendations, when used, should be linked to the 
findings. 

The INTOSAI standards state how an audit report must be to be relevant and useful for 
parliamentarians. 

The reporting standards to be met include the following3:  

 Objectives and scope: The performance audit report should state clearly the objectives and 

scope of the audit. This information establishes the purpose and boundaries of the audit.  

 Completeness: The audit report should contain all information and arguments needed to 

fulfil the audit objective and provide answers to the audit questions. The relationship 

between audit objectives, findings and conclusions needs to be complete and clearly stated.  

 Accuracy: Evidence presented in the audit report should be true and comprehensive and all 

findings correctly and logically portrayed. The readers need to know that what is reported is 

reliable. A high standard of accuracy requires an effective system of quality assurance.  

 Objective and logical: The presentation of the report should be balanced in content and tone. 

All evidence should be presented in an unbiased manner. Auditors should be aware of the 

risk of exaggeration and overemphasis of deficient performance. The audit report should 

only present arguments that are logically valid.  

 Clarity: The audit report should be clear and easily understandable as well as written to suit 

the capabilities, interests and time constraints of the readers. The language should be as 

simple as the subject matter allows. Technical terms and unfamiliar abbreviations must be 

                                                 
2
AFROSAI - E Performance Audit Template Manual 2010, chapter 4.14. 

3
 AFROSAI - E Performance Audit Template Manual 2010, chapter 4.15. 
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defined. Tables, charts and photographs should be used where appropriate to present and 

summarise complex information. Clarity is improved when the report is concise. 

 Timeliness: The audit report should be prepared and issued in a timely fashion in order to be 

of greatest use to readers and stakeholders, particularly government and the audited entity 

that have to take the necessary corrective actions. If the report is delayed the 

implementation of the audit recommendations or other changes caused by the audit will also 

be delayed. The findings can also become obsolete. A report that comes too late is no longer 

relevant for the users. 

Report writing becomes a challenge with so many requirements to a high quality performance audit 
report. There are several common challenges in report writing. Some of the major challenges are 
related to: 

 How to get the reader interested in the subject; 

 How to properly introduce the audit area and the audit object to the reader; 

 How to give a concise presentation of the audit methodology; 

 How to present the assessment criteria as the normative basis for the audit; 

 How to document the existence of the audit problem; 

 How to clearly present the structure, language, figures and tables; 

 How to bring out the most important findings; 

 How to link the verified audit problem to causes and effects; 

 How to write good conclusions and smart recommendations; and 

 How to present the report in a reader-friendly way to different target groups. 

The purpose of this guideline is to give the performance auditor advice and practical guidance to 

overcome these and other challenges. The guideline is meant to be more detailed and give more 

examples in report writing than the performance audit manuals used in the SAIs. 

The guideline consist of a chapter on how to organise the report writing process and the quality 
control (2), followed by a chapter with a thorough discussion on each part of the report (3). The last 
chapter covers the structure of the report, use of tables, figures and photos and the use of an 
appropriate language (4). 
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2. How to approach and organise the report writing process  

2.1 The writing process  

To make the writing process effective it is important to recognise that for many auditors the writing 

is part of the analytical process – where different pieces of evidence are brought together into a 

larger picture and compared to criteria, developing findings that answer the audit questions, draw 

conclusions and develop recommendations. To make the report reader-friendly, however, it is 

usually necessary to revisit, re-structure and partly re-write the draft in order to produce a report 

that meets the needs of different groups of users and other readers; this requires analyses of the 

different needs as preparation for report writing. It is also important that Supreme Audit Institutions 

(SAI) put in place appropriate procedures for quality control review of draft reports. 

The process of writing the report can be broken down into four stages, namely: 

1. Identify the main messages of the report; 

2. Draft a synopsis; 

3. Write and re-write a draft of the report to develop the content with proper linkages between 

the audit objective, audit questions, findings, conclusions and recommendations; 

4. Rewrite the draft to improve structure and readability. 

The auditors are advised to follow these stages during the report writing process. This will make sure 

time is not wasted on writing parts of the report which are not particularly important. On the other 

hand, in reality it happens that the auditors discover the main message of the report when they have 

done a lot of analytical writing. It may then be necessary to revise the main message of the report 

and re-visit the synopsis. 

The auditors are advised to reach to stage two early in the process, to sort out a good structure of 

the report. The whole fieldwork does not have to be completed before main parts of the report can 

be written, but certain parts, for example regional visits or initial overall studies at head office should 

be finished. The writing process should be integrated with the analytical process. 

2.2 Identify the main messages of the report 

First you need to get your evidence sorted out to know what you will be able to verify. Then you 

need to start writing in order to come up with what you really want to say. It is important to 

emphasise that normally you need to re-consider and re-write the text several times before it comes 

out clear, accurate and reader-friendly. 

During analysis of data the auditors should begin to identify the main messages coming out of the 

audit. These are the big picture issues or headlines that summarise the most important findings, e.g.: 

 Only one third of contracts are awarded on a competitive basis; and 

 Failure to Prepare Strategic Plan and Annual Reports. 

For each audit question the auditors may first through a brain-storming session in the team list all 

the audit findings they expect to have sufficient evidence, to assess and structure these in line with 

the audit questions to be (e.g. have all major procurement been subjected to competitive tendering). 
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The auditor then needs to come to a judgement as to the importance of the findings (e.g. did the 

audit find small exceptions to the general rule of competition or major shortcomings). And finally the 

auditors need to think through what actions can be taken to address the weaknesses identified (e.g. 

whether changes are needed in procurement policy; whether better training of staff is required; 

whether the guidance needs to be updated; etc.). 

There are different processes that can be used to help auditors analyse audit findings. These include: 

 Structured discussion amongst the auditors. This is where the whole audit team discusses 

the objectives and findings of the audit and the conclusions and recommendations that could 

be drawn from the findings. It is often much easier to think through issues as a group than on 

your own. At the end of the meeting the lead writer should have a list of all the main findings 

and recommendations against each of the objectives of the audit. This can be done by 

inviting to a Dinner Party, using post-it notes to find a structure etc. 

 Solo analysis through some form of “mind mapping”. This is literally a map, which seeks to 

connect the audit objectives, audit findings and possible recommendations (e.g. finding x 

supports links to issues a, b, c and d; finding y links to issues a and b). 

Hints & tips 

In thinking through the main messages of the report try and imagine you have to orally explain 

your findings while taking the elevator (30 sec. to 1 minute) to someone that knows nothing 

about the subject. Try this out loud to team members using a stopwatch and keep repeating the 

message until you are satisfied. You will be surprised how quickly the main messages of the 

report become clear. 

2.3 Draft a synopsis 

A synopsis is an outline or skeleton of the report. The synopsis sets out the main structure and lists – 

in the form of keywords or short sentences – the intended content under each heading. The aim of 

the synopsis is to sketch the structure and broad content of the report. It is a useful tool for the audit 

team to structure the ideas on how to write the report. Sometimes it may be possible to start top 

draft the synopsis so early that it even can influence the collection of data. This also makes it possible 

for the auditors to start writing the draft report early. 

In the synopsis, the auditor should: 

 Sketch a logical structure of the report; 

 Indicate the findings, together with supporting evidence, and conclusions to be included in 

the different sections; and 

 Identify necessary annexes. 

A logically organised synopsis helps the auditors to decide what to keep, what to develop and what 

to reject before writing any pages. In short, the auditors should know what message it wants to 

deliver to the stakeholders. When compiling the synopsis, the problem-tree technique as well as the 

input-output model may be used as tools to structure the analytical process, particularly if these 

techniques already have been used when identifying the audit problem. 
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It is advisable to present the synopsis to top management for discussion. This will give management 

an opportunity to assess if the synopsis is in line with the expectations and enable them to provide 

input, comment on the general direction, content and possible conclusions. This will save time by 

reducing the need for revision and amendment at later stages of the drafting process. 

2.4 Write and re-write a draft report to develop the content (analytical writing) 

Analytical writing is a process of finding out what you want to say in detail based on the evidence you 

are able to put together and present. You have to write a text that presents finding by comparing the 

evidence on the conditions with audit criteria and show linkages between different findings or parts 

of the report. 

During the drafting the auditors' understanding of what they have observed, will grow and the 

understanding of the issues in the report will develop and improve. Some of the analytical problems 

faced by the auditors may not be clarified until they start to write. Therefore the auditors need to let 

this process take its time until they are clear about what they want to say; i.e. what the detailed 

message are in the report as a whole as well as in different parts. 

2.5 Rewriting to improve structure and readability 

Considering the needs of the audience 

All written reports require an understanding of the audience. Who will read the audit report? How 

familiar will they be with the subject matter? What is their need for information? Moreover audit 

reports often speak to multiple audiences:  

 PACs, with less knowledge and understanding of the subject and critical points raised, unless 

there are clearly explained or signposted;  

 The management of the audited entity, who will know more about the subject matter but 

will want to be able to assess the weight of evidence supporting the auditors conclusions as 

well as the logic supporting key recommendations; and 

 The media, who may know little about the subject but will want to identify the main 

messages and the possible headlines they can write. 

The following points are general advice for addressing the needs of the audience: 

 The topic dealt with should be significant and of interest to readers. Relevance of a 

performance audit report begins with a clearly defined and focused audit problem and 

objective. Given the audit problem and objective, the audit should be suitably designed, 

including audit questions, audit scope and choice of methods –and this should be described 

in the report.  

 The report should give the reader an appropriate understanding of the organisations, 

systems and processes subject to audit and how they are expected to function. This makes it 

easier for the reader to understand the findings, conclusions and recommendations in the 

report. 

 The report should clearly identify and address the target audience. The goal is to convey the 

information to the audience with the greatest clarity. 
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According to INTOSAI Subcommittee for Performance Audit, the diverse audience for performance 

audit work suggests that SAIs should address different groups with different products. Performance 

audit work can lead to a number of separate products in addition to the report, including summaries, 

leaflets, brochures, press releases and presentations. Each of these should be written in a style 

tailored to its specific audience. To produce reader-focused, interesting, challenging and widely 

appreciated reports, the SAI should research among its audience groups in parliament, government 

and wider society to decide on the most effective format and style for achieving the desired impact. 

Preparing a communication plan can provide a structured way of thinking about how to effectively 

reach different audiences.4 

Hints & Tips 
It is sometimes useful to think of the Executive Summary as being written for the PAC; the report 
as being written for the audited entities and the annexes as being written for those academics or 
specialist staff with an interest in the field. 

Reader-based writing 

Performance audit reports usually deal with complex issues. The final report must be written to meet 

the needs of different groups of users and other readers. To make a report that is clear and concise 

and presents a coherent story that is easy to read almost always requires the draft report to be 

restructured and rewritten more than once, , before as well as after feedback from different levels of 

management. This is probably the part of the writing process where most auditors underestimate the 

necessary work to be done. A rule of thumb is that there is at least a need of five versions of the draft 

report before it has reached a sufficient level of quality. This process is time consuming and 

sometimes it can be frustrating to re-write paragraphs many times. To make the writing process 

efficient the auditors therefore can divide the work between them and work in different documents, 

before merging the different parts into one draft report. Finally, the draft report can be edited by all 

the auditors together by projecting the report "on the wall". 

It may be helpful to the reader to introduce each main chapter of the report with a short description 

of the content and main message of the chapter. 

Some SAIs have access to communication experts. Performance auditors should seek cooperation 

with communication experts, if available, to find ways to make the reports more reader-friendly, 

without compromising on other standards for the reports. 

2.6 Quality control during the report writing phase 

Quality control involves the policies and procedures through which the SAI ensures that all phases of 

the audit (planning, execution, reporting and follow-up) are carried out in compliance with SAI 

auditing standards, rules, procedures and practices in line with best international practices. It is a line 

function and the responsibility lies with management. Management’s responsibility for quality 

control is mainly related to the vetting and approval of Performance Audit products. Regular 

information to management on progress and challenges between the decision points should also 

contribute to quality control by management. The daily quality control is the responsibility of every 

staff member of the SAI. In each team the quality control must be discussed and agreed upon before 

                                                 
4 Making Performance Audit Reports Reader-friendly, INTOSAI Performance Audit Sub-committee. 
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the audit begins. Quality control must be built into the whole audit process, from planning and 

selection of audit problems to the follow-up stage of completed audits. The quality control should 

among other things ensure a proper design of the audit. The key to defensible conclusions (main 

messages) is a sound design. 

Management's responsibility for quality control 

Producing high quality performance audit reports requires active involvement and feedback from 

management. Performance auditors may have developed good skills, but there will always have to be 

a substantial role for management to play. Management is needed to take the right decisions on how 

a report should be presented. Sometimes auditors responsible for execution of performance audit 

projects will are too focused on certain details and not be able to see what a good structure is and 

what important findings are. It is also typical that performance auditors become tired of a report 

after working on it for a long time and therefore want to just get it done without necessarily ensuring 

a high quality. Regardless of how the quality control process is organised, top management need to 

be involved also between the approval of the work plan and the review of a draft report. Good 

practice is to regularly involve top management in monitoring the progress of the audit and the 

emerging findings as well as take part in discussions on major issues that may arise and at important 

steps such as the synopsis. This will facilitate the review of draft reports as top management already 

is well informed and has a clear buy-in in the project. 

The role of the different managers in doing the quality control will vary. The major part of quality 

control is ensured by the team leader and the operational manager. The responsibility of quality 

control of the senior manager and top management (DAG and AG) is supposed to be more limited 

and rely on the quality control already done by the team leader and the operational manager. The 

complexity of performance auditing and the potential risk for the SAI, however, motivates that all 

draft reports are properly reviewed also by top management.  

The process of doing the quality control differs between SAIs. The draft report should be reviewed by 

each line management level. In some SAIs the review is done jointly by two managers, in parallel by 

all managers or in a meeting with the whole unit. AFROSAI-E recommends SAIs in the region to 

establish a system with independent pre-issuance review in all performance audits, a system that 

needs to be adjusted to the level of development of the SAI. See further AFROSAI-E Quality 

Assurance Handbook, Appendix 6.1. Some SAIs also systematically uses reviews by subject matter 

experts. 

How should management do the quality control during the report writing phase? The most important 

time when management is involved is through the process of approving and giving feedback to the 

draft report. The plan of the audit will state when which level of management should expect the 

draft report for vetting and quality control. In addition, management can be involved during the 

development of a synopsis at an early stage of report writing.  

Management can be invited to give comments to the synopsis. For some teams and projects this can 

be important, especially if the auditors are unsure of the overall structure of the report or which 

finding is most important. Finally, management must also follow up on the general progress of the 

team during regular progress meetings. In these meetings, clarifications on how the report should 

look like can be given.  
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If the management plays an active role in the report writing process by providing direction and 

guidance, which enhances the quality of the report, it will be more motivating for the auditors to 

write the report. However, the involvement of management is depending on their capacity and the 

need for feedback in the teams. Some teams have little experience in report writing and the team 

leader will then need more guidance by the operational manager.  

Below is a list of questions that summarises the standards for performance audit report writing 

according ISSAIs. The SAI can develop an own checklist for quality control review of draft reports, or 

use the questions below, to help managers to do the quality control effectively.5 A checklist also 

makes the quality standards for performance audits clear to staff. Thus, the checklist can also help 

team leaders in ensuring the quality of the work before submission to management. In summary, the 

standards require performance audit reports to: 

1. Present an important topic within the mandate, related to the economy and efficiency with 

which resources are acquired and used, and the effectiveness with which objectives are met and 

disclose standards followed and if regulations limited the audit. ISSAI 3100:11,27-28 

2. Present an appropriate audit design (objective, questions, scope, assessment criteria, 

methodology, principles for sampling, limitations to data) to efficiently collect sufficient evidence 

to conclude against the objectives and answer the questions. ISSAI 3100:13,16-17,30; 

Manual:4.15-16 

3. Give the reader an appropriate understanding of the organisations, systems and processes 

subject to audit and how they are expected to function. ISSAI 3100:30; Manual:4.16 

4. Present findings, congruent with the objective and put into context, based on complete, 

reasonable, sufficient, relevant, valid, reliable, accurate, objective and logical audit evidence 

(referring to sources) answering the audit questions and when appropriate analysing the causes 

and consequences. ISSAI 3100:20-21,30-31;3000:4.3; Manual:4.10-11, 15 

5. Present reasonable conclusions (statements deduced from the findings based on evidence, 

rationality and project specific criteria) clearly distinguished from findings and congruent with 

the audit objective, audit questions and findings. ISSAI 3100:21,31; 3000:4.5; Manual:4.12 

6. Add value, improve the knowledge, highlights improvements needed and (usually) include 

reasonably specific and practical recommendations relevant for PAC and the responsible entity, 

logically addressing the causes of findings usually without requiring additional resources. ISSAI 

3100:31-32; 3000:4.5; Manual:4.13 

7. Be balanced and fair in tone and content, convincing, constructive, reader-friendly (for PAC and 

other readers), clear, concise, well designed, without typographical errors and using simple un-

ambiguous, non-technical language with explanation of abbreviations. ISSAI 3100:31; 

Manual:4.15-18 

                                                 
5
 The checklist is an extract from the Quality Control/assurance questions for performance audits in Appendix 

6.3 of AFROSAI-E Quality Assurance Handbook (2012). Reference to "Manual" means the AFROSAI E 2010 
Performance Audit template manual. ISSAI 3100 systematically refers to ISSAI 100 – 400 and ISSAI 3000. Therefore 

references to ISSAI 100 – 400 and ISSAI 3000 are here only made when the reference to ISSAI 3100 not clearly is sufficient. 
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8. Be well structured, with focus on main findings, and appropriately use a submission letter, table 

of content, an executive summary, a logical structure of chapters, informative headings, annexes, 

tables, charts and photographs. ISSAI 3100:31; Manual:4.15-18 

9. Be sent to the audited entity, with an invitation to comment on findings, conclusions, and 

recommendations; documenting the feedback, analysing disagreements, correcting factual errors 

and documenting changes of the report. ISSAI 40:5; 3100:34; Manual:2.14, 4.18.2-4 

The team leader's and the team’s responsibility for quality control 

Team leaders must do their best throughout the writing process to ensure that the draft report is in 

line with the standards. In addition, the team leader has a particular responsibility to ensure that the 

report contains no errors. Errors will always be made when writing the report, for instance:   

 Irrelevant information  may be included; 

 Numbers may be wrongly calculated or typed; 

 Summaries from document reviews may not be properly referenced and the information 

from the summaries may not be the same as that appearing in the report; 

 Interview data may be used although there are too few statements for it to qualify as 

evidence; 

 Interview data may be interpreted wrongly; 

 Incorrect references may be used; and 

 There may be a loose connection between questions asked and answers given. 

It is sometimes difficult for the operational manager to see such errors, although working papers are 

reviewed. To minimise such errors, the team leader can check all the sentences and elements of the 

report. The team leader has an on-going responsibility to do this, but it will be necessary to take a 

comprehensive check of the report at a final stage, for instance before the report is submitted to the 

AG for final approval. 

According to the standards the final report should be cross-referenced to the audit file. This can be 
done in different ways. As a minimum SAIs are recommended to adopt a practice of cross-
referencing main findings to the evidence that supports them. In this manner, it would be clear that, 
for instance, a main finding that enforcement processes were weak flowed from interviews with area 
enforcement leaders, activity reports and budget documents. The description need not be 
exhaustive; it is a way for supervisors and reviewers to have comfort that main findings are well 
supported by audit evidence. A tentative working paper may have the following columns: 

 Major finding; 

 Significant evidence; 

 Source; and 

 Reference to the file. 

An alternative approach is to do the final quality control by printing the report and mark every 
sentence and reference it when it has been checked. 

Of course all team members have a responsibility to contribute to audit reports of a high quality. 

There are many features in modern work processing software that can make it easier for auditors to 
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draft audit reports. Appendix 1 gives brief explanations of how the following four functions, usually 

available in word processing software, can help the auditors to produce high quality reports: 

 Use of headline styles to ensure consistent headlines, easy navigation in the document, an 
automatic synopsis and a table of contents;  

 Track changes and insertion of comments for easy communication about reviewing; 

 Spell check; and 

 Automatic numbering of captions to tables, pictures and graphs and automatic cross-
referencing in the text to these captions. 

Saving word-documents as a PDF is also a useful function. It is advisable to save the draft report sent 

to the audited entity as a PDF, to ensure it is not re-edited by a mistake. The finally approved version 

of the report must also be saved as a PDF. 

Make use of communication experts, if available 

Some SAIs have communication experts employed to improve the communication with main 

stakeholders and the general public. The perspectives of communication experts and performance 

auditors often differ. The skills the communication experts usually have in making the message clear 

and adjusted to the needs of the reader can make a significant difference to the readability of a 

report. On the other hand, the communication experts should not be expected to be fully conversant 

with standards for performance auditing. The two professions need to meet and find ways of using 

each other competence to improve the audit report. 

If the SAI has access to communication experts we recommend that the following parts of the report 

are reviewed by a communication expert (possibly also other parts): 

 The executive summary; 

 The conclusions chapter; and 

 The recommendations chapter. 

Obviously a communication expert should also be consulted in writing the press release about the 

report, if any. 
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3. The content of the different parts of the report  

The naming and exact structure of the chapters in the report varies between SAIs. The 

chapter headlines used in this guideline must not be seen as prescriptive for the chapter 

headlines in a performance audit report. However, the advices on contents and presentation 

are meant to be useful for all SAIs. This also applies for the formal parts of the report, such 

as the front page and preface. The advices given below are meant to be useful principles and 

considerations for most SAIs, although every SAI will choose their own lay-out of the report.  

3.1 Formal parts of the report 

Front Page and back Page 

Typically the following information is useful on the cover page: Title of the audit, the name of the 

audited entity, information on the type of the audit, year or volume number, and the name of the 

audit office ("National Audit Office"). Contact information for the SAI can be put in the front cover or 

at the back page.  

 

Preface or letter from the Auditor General 

This part is usually short and basically includes a reference to the audit act mandating the Auditor 

General to conduct and report audits. The part may also include a reference to the audit standards 

used as a basis for the audit, such as ISSAI 3100 and the national performance audit manual and 

information from the Exposure of ISSAI 100.  

Title 

Report number and 

year 

An illustrative picture.  

NB: Make sure the 

picture is relevant and 

that the SAI has the 

right to use it. 
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Table of contents 

In principle, more than three levels of numbered headings should be avoided. The purpose of 

numbered heading is to give an overview of the report in the table of content, as well as guide the 

reader through this structure as they read the report. If the structure of numbered headings is too 

detailed, the reader loses the overview and orientation that is the whole point. Instead of adding 

more levels of numbered headings the auditors can use different types of un-numbered subheadings 

to clarify the structure within a numbered Section. The reader needs to be guided through the 

report. It is often useful to start Chapters, and sometimes even Sections, by giving an overview of 

what will be presented in them. The longer the text is, and the larger number of headings that is 

used, the more important it is to give an overview to guide the reader. 

List of abbreviations 

It is useful for the reader to have all abbreviations used in the report in one list. In the list the 

abbreviations must be sorted alphabetically. In MS Word, you can sort a one-level bulleted or 

Example of table of contents 

Executive summary …………………………………………… 5 

1 Introduction .………………………………………………. 9 

1.1 Background  ………………………………….. 9 

1.2 Audit objective, questions and scope ……..………. 10 

1.3 Methodology ……..……………………………….. 11 

2 Description of the audited activity……………………….. 14 

2.1 The goals and objectives of the Medical Stores…… 14 

2.2 Requirements regarding the procurement of drugs … 14 

2.3 Requirements regarding warehousing and  

distribution ……………………………………….. 15 

3 Findings …………………………..………………………… 21 

3.1 Medical Store’s supply of drugs to the hospitals and  

health centers ………………………………………. 21 

3.2 Planning of procurement ………………………….. 22 

3.3 Warehousing and distribution ……………………… 23 

3.4 Financial management and systems of internal  

control in Medical Stores…………………..……..  29 

3.5 Technical supervision by the Ministry of Health …. 34 

4 Conclusions ………………………..………………/………. 36 

5 Recommendations ………………………..………………… 38 

5.1 Recommendations to Medical Stores……………… 38 

5.2 Recommendations to the Ministry of Health ……… 40 

Annex 1: Interviews conducted during the audit ……….……..……… 41 

Annex 2: Documents reviewed during the audit……………………… 43 

Annex 3: List of rented warehouses in 2011……………………….…. 44 

Annex 4: Comments from the Ministry ………………………………. 45 

 

Headline level 1 is 

clearly distinguished 

from headline level 2, 

by being both bold 

and having different 

intendation 

Chapter numbering  

Page numbering  

Main groups of 

findings. 
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numbered list so that the text is in alphabetical order. You do this by selecting the text in a bulleted 

or numbered list. Then on the Home tab, in the Paragraph group, click Sort. 

When the abbreviations are presented in the text for the first time, the full meaning, names etc. 

must be stated, followed by the acronym in brackets. Limit the use of acronyms to those that are 

commonly known, for example UN and GDP, and those that are used often in the report at the same 

time as they are rather long. 

3.2 Executive summary 

The executive summary is the most read chapter in a performance audit report. Many readers will 

not read anything more than the Executive Summary. This may also be the case for the main 

recipients in the Public Accounts Committees, Parliaments and top management of the audited 

entity. The Executive Summary should make the reader able to understand what questions were 

raised, how the audit was done, the main findings, conclusions and recommendations.   

It is crucial that the information is given in a summary form and only containing the most important 

information of the report. The executive summary will typically be 2 - 4 pages, but the length is of 

course depending on the width of the audit.  

There is no point in writing the executive summary until the other chapters of the report and the 

recommendations have reached a certain level of quality. For many teams, the first review by the 

operational manager is necessary to establish a proper structure and clarity on what is presented in 

the report. Audit teams who start writing the executive summary before the rest of the report has 

reached a certain level of quality, will typically have to make substantial adjustments to the executive 

summary, which is not efficient. There is also a risk that important final adjustments to the findings 

chapter(s), the conclusions and recommendations are not properly reflected in the final version of 

the executive summary.  

A good strategy for writing the executive summary is to summarise the findings and conclusions so 

that the reader gets a quick overview of the most issues. Some summarised information about the 

evidence supporting the findings is usually also needed. However, some sentences and elements 

from the findings chapter that supports the conclusion 

Before the summary of findings and conclusions, it is advisable to include the following in the 

executive summary:  

 A few sentences from the background, where the main political goal of the area comes out and 

the government entity responsible. This will often be enough to convince the reader of the 

importance of the audit. Some prefer to include an explicit reference to the motivation of the 

audit, but this must be done with caution. It can confuse the reader if the risk that motivated the 

audit is stated clearly in the beginning, as it can be misunderstood as a finding by the reader. 

 The objective and the audit questions  

 A few sentences on the data collected and methods used 

At the end of the executive summary, the major recommendations 

must be presented. It would normally be relevant to include a 

sentence that the audited entity has been provided with the 
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opportunity to comment on the report. Sometimes a few general comments of the audited entity 

may also be relevant to include in the executive summary. 

  

3.3 Introduction 

The introduction contains background information and information on the audit objective, audit 

questions, scope, assessment criteria and methodology.  

Example of executive summary  

The objective of the Supply of Teaching and Learning Materials Programme is to 
procure, store and distribute teaching and learning materials to schools in order to 
support free primary education. Funding for the supply of teaching and learning 
materials programme had increased over the years from MK 743 million in 
2006/2007 to MK 1,222 million in 2008/2009.1 The Ministry of Education Science and 
Technology has the overall responsibility for the programme, as well as the 
responsibility for planning and procurement of materials. To achieve the objective, 
the following audit questions were used:  
 
a) To what extent are the teaching and learning materials distributed on time and in 
the right quantities?  

b)  …….. 

The audit covered the 2007 and 2008 academic years. Interviews, documentation 
reviews and physical observations were carried out to collect data for the audit. 
Interviews were held with representatives from the Ministry of Education and at 
various levels of the Supplies Unit Directorate. Data was collected from warehouses 
and sampled schools in all regions.  
 
A major finding of the audit was that several primary schools were not getting the 
procured materials. Between two and four percent of the materials delivered at 
Liwonde Warehouse did not reach the schools in the Southern Region. In the Central 
and Northern Regions, there were less problems of leakage. However, schools in 
about 150 zones in the Central Region did not get all the teaching and learning 
materials which they were supposed to receive in 2008. At the same time, several 
secondary schools in the Central Region received materials meant for primary 
schools. In many schools Teaching and Learning materials were arriving after the 
school year had started. This was due to a number of factors including late awarding 
of contracts by the Ministry, delayed delivery of materials by suppliers, inefficient 
warehouse management and insufficient distribution capacity.  
 
Recommendations 
The Supplies Unit directorate should establish a system to ensure adequate 
monitoring and supervision of warehouse operations. The Supplies Unit should in this 
regard consider introducing an electronic system for warehouse logistics.  
 
The Ministry indicated that it has instituted a number of measures to address the 

anomalies. The master list for schools would be updated regularly to ensure that 

enough materials were available for distribution and all schools benefit from the 

program. Proper follow ups would be made on suppliers so that materials are 

delivered on time and with the right quality and quantities. 

Source Performance audit report on the supply of teaching and learning materials 
programme in the Ministry of Education, Science and Technology. Malawi. 2011 

A short version of 

the background 

with key infor-

mation about 

what the audit 

was looking at 

(objective and 

audit questions). 

A brief summary of 

how the audit was 

done (data and 

methodology). 

Major findings, where 

some evidence on con-

ditions are presented in 

relation to criteria and 

linked to each other. 

When appropriate, 

additional causes and 

consequences are pre-

sented. Everything 

should are linked into a 

coherent story. 
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that the audited entity 
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to comment on a draft 

report. Sometimes the 

overall response of the 

audited entity may be 

presented in the end of 

the Executive summary.  
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Background 

The background should be brief and only present information for the reader to become familiar with 

the audit area and understand the results of the audit. To get the reader interested, the audit has to 

be presented in such a way that it becomes obvious that it is relevant and important. Using many 

sub-headings in the background information or the audit design and methodology in the introduction 

will typically disturb the flow for the reader. 

The following information is often relevant in the background (remember to make it brief):  

 The main political goals or main legal requirements of the area: only strictly relevant goals and 

regulation should be included. A presentation of the vision and mission of the audited entity 

does often not fit, as it is not strictly related to the audit or it is too general information. A 

detailed reference to the act is also hampering the flow and interest of the reader, and may 

instead be put into a footnote.  

 Historical information: for instance if there has been a change in regulation in the area or 

establishment of a new government unit a certain year, this can be useful background 

information. 

 Statistics showing the importance of the area without presenting the performance: for instance in 

an audit of distribution of drugs, the number of public health facilities and requests for drugs 

every year can be presented in the introduction. This enables the reader to understand the 

magnitude of the area being audited. However, how these requests have been responded too 

should not be presented in the background, as that is performance related information which 

sorts under the findings chapter.  

 Organisational units and their responsibilities: which government units are important in this area 

and what are their responsibilities related to the area being audited? 

 Resources provided by Parliament to this area and other funding mechanisms if any: the budget 

and possibly the number of employees can be relevant to mention. Note that this can be 

presented in two sentences for the reader to get the brief background. A more detailed 

presentation on resources can be given in the chapter on process and systems description. 
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The motivation for starting an audit is a result of an assessment of the relevance, auditability and 

potential for change. It is mainly the relevance of the audit that is of interest for the reader to 

understand. As the audit mandate usually would be mentioned in the preface or a letter from the 

Auditor General, the motivation of the audit can usually focus on the importance of the audit 

(materiality) in terms of funding, importance to citizens or the public administration, the country’s 

economic development and the risk for performance problems in government entities in the area 

(the risk that the operations not are economical, efficient and/or effective). Usually the whole 

introduction gives the reader the understanding of the motivation for starting the audit.  

Be careful about how risk factors motivating the audit in the introduction are presented. The risk 

factors motivating the audit are different from findings. They must be presented as indications of 

problems which made it important to initiate an audit. Risks must be presented short and as an 

indication, to avoid that the reader interprets it as a finding of the audit.6 Typically one or two 

                                                 
6
 If the problems motivating the audit were well known and documented before the audit started, it can be 

questioned whether the audit was necessary in the first place.  

Example of introduction 

The Medical Stores (NMS) is a treasury fund under the Ministry of 

Health (MoH), whose main purpose is to procure, store, and supply 

quality assured and affordable medicines, medical equipment and 

medical supplies to all public health facilities. It should ensure 

continuous, uninterrupted and adequate supply of approved quality and 

affordable medicines and other medical supplies to public and other 

approved health facilities.
1
 

The Medical Stores has its headquarters and a central warehouse in the 

capital, as well as a warehouse in all regions. The Medical Stores has a 

fleet of trucks to transport drugs between the warehouses and to public 

health facilities. 

The Medical Stores gets funds for drugs and medical supplies from both 

government and donors, but is operating as a revolving fund which does 

not receive annual funding from Parliament. It is required to operate at 

a profit to sustain itself in terms of supply of drugs and medical supplies. 

The total budget has increased over the last years. While the budget was 

2.6 billion in 2006/2007, it was 5.2 billion in 2008/2009.
2
 The Medical 

Stores was supposed to have 207 posts in total in 2007/08 and 2008/09 

financial years. The Medical Stores was designed to have 250 staff in 

total, while by the end of 2011 the number of staff was 199.
 3

 

The audit was initiated due to the complaints by the general public 

regarding shortage of drugs and medical supplies in hospitals and health 

centres.
4
 

1 
Medical Stores Act 

2
 Medical stores budgets 2006-2009 

3
 Statutes of Medical Stores 

4 
See monitoring reports 2008. 
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sentences are sufficient for presenting the risks motivating the audit. Possible formulations 

presenting the risks motivating the audit can be:  

 "The audit was initiated following concerns raised in the media about …"  

 "Successful implementation of the program is dependent on cooperation between a large 

numbers of actors at different levels. This represents a risk of inefficient implementation of the 

programme and motivated the audit." 

Avoid stating the obvious in the introduction, such as "this is a performance audit report" or "this 

report presents the findings of performance audit on the drug distribution and dispensation in the 

Ministry of Health – Hospitals and National Medical Stores." The reasons are both the fact that it is a 

performance audit report and the contents of the title are already presented on the front page. 

Repeating information will only make sure the reader gets bored.  

The step-wise process of conducting a pre-study and then a main-study is usually not necessary to 

present in the final report. The text of the report must be strictly related to necessary information. 

Avoid statement like "The audit was conducted in two phases namely; the preliminary audit which 

was carried out from 25th May, 2009 to 23rd October, 2009 and the main audit which was carried 

out from 09th February, 2010 to 09th October, 2010".  What is presented in the final report is the 

final result of the whole audit exercise. It does not matter if data was collected during the pre-study 

phase or the main study phase as long as they are valid and reliable. The time covered by the audit is 

presented related to the scope, not related to the background information. 

Audit objective, audit questions and scope 

The audit objective, audit questions and scope will together inform the reader what the audit is 

about. The objective should be a precise statement of what the audit intends to accomplish. The 

audit questions and sub-questions further specify in a neutral manner what the audit report 

addresses – both in verifying the existence of the audit problem and analysing the causes to it. Finally 

the scope specifies what entities that are audited, what programs or activities that are covered, the 

time period and if there are limitations in the geographical scope. If there are limitations to what the 

SAI can audit according to regulations, this would be the place to clarify this and interpret how these 

limitations may have influenced the audit.  

The audit objective, audit questions and scope are formulated during the planning of the audit, but 

the team must ensure during the report writing phase, that there is a direct correlation between the 

audit objective, audit questions and what the report actually contains. The audit objective and 

questions should reflect the 3E's. Insufficient understanding of the area during the planning, or 

failure to collect the planned data, may justify a change of the audit objective and audit questions 

during the audit exercise. 
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Example of presentation of audit objective, audit questions and scope 

The objective of the audit was to assess whether the Medical Stores was carrying out its operations efficiently 

leading to continuous, uninterrupted and adequate supply of drugs and medical supplies to health facilities. 

The objective was specified with the following audit questions:  

1. To what extent is the delivery of drugs and medical supplies by medical stores meeting the requests of 
health facilities? 

2. To what extent is the procurement of drugs and medical supplies planned and carried out in order to 
secure continuous, uninterrupted and adequate supply to the health facilities? 

3. To what extent is the Medical Stores storing and distributing drugs efficiently?  

4. To what extent has the management of Medical Stores established a satisfactory internal control? 

5. To what extent is the Ministry of Health (MoH) providing technical supervision to ensure efficient 
operations at the Medical Stores? 

The audit focused the years 2009 - 2011. The MoH and the Medical Stores were the auditees. The operations 

of procurement, storage and distribution of drugs by the Medical Stores were covered by the audit. 

A common mistake is to present sampled data sources as the scope. The sampling is not relevant 

together with the scope and should be sorted under methodology. The reason is that if the sample is 

presented together with the scope, it creates an impression that the findings are only relevant for 

these sampled units. Usually the scope is wider than the sampled units. For instance, the findings are 

relevant for more units than only the sampled districts, schools or police stations. Sampling is the 

process of deciding how many and which of the elements in the population in cases where it is either 

theoretically or practically impossible to study the whole parent population. A Performance Audit 

project often tries to establish findings that are relevant for the whole country, not only the sampled 

units. 

A logical and brief presentation of methods used 

The data collection methods used to answer the audit question should come out clearly. The 

presentation of the methods can be structured along the audit questions or the type of data. What 

works best depends on what gives the least number of repetitions and the greatest reader-

friendliness. Often a structure along the audit questions is recommended as this makes it easier for 

the reader to assess the basis of the audit and thereby be convinced of the quality of the findings. 

At the same time as the reader need to understand the methods used, the presentation need to be 

brief. Otherwise there is a great risk that the interest of the readers is lost even before the main part 

of the audit has been presented. Longer descriptions of the used methodology are usually best 

presented in an appendix. 

The criteria or reason for the sampling must always be given. A detailed list of data and sources can 

be given in an appendix, for instance a list of all places visited, documents collected or 

representatives interviewed. Please note that although details of the data are given in an appendix, a 

summary of this must be presented in the methodology chapter. It is not good enough to just refer to 

the appendix.  
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Example of presentation of the methodology 

Interviews, documentary reviews and physical observations were carried out to collect data for the audit. 
 
Methodology to assess the delivery of drugs compare to the requests (audit question 1) 
An examination of records for 2008-2010 at all medical stores offices and warehouses was carried out to 
establish whether drugs were supplied according to the requests. The records showed drugs and medical 
supplies received from suppliers and issued for distribution to health facilities. Whether drugs were supplied 
according to the requests of the health facilities were calculated by a comparison of what was ordered and 
what was issued. 

A sample of nine drugs and medical supplies was selected for the analysis. Several antibiotics were sampled as 
these are relatively expensive and therefore prone to abuse. The other drugs were sampled considering all 
areas of the health facilities.  

District health officers, pharmacists and the chairman and members of the drug committee (where available) 
were interviewed at fourteen hospitals. The hospitals were selected in order to obtain information from a 
representative sample in all the regions. All the four central hospitals were visited, while a sample of ten 
district hospitals were selected based on the region and the geographical location (being from different 
directions and delivery routes).

2
 

Under each district hospital visited, three health centres were selected and visited. The health centres were 
also selected basing on different directions and delivery routes. The purpose of these interviews was to 
establish how reports on drug consumption were produced and how drugs were managed. The list of 
interviews conducted is in annexure 1. 

A comparison of the receipts and dispatches at medical stores warehouses were carried out to establish 
whether there was any leakage. The opening and closing balances and the board off of the sampled drugs and 
medical supplies were taken into account. 

How to present the audit criteria 

ISSAI 3100 states that the audit criteria, which can be of a qualitative or quantitative nature, should 

be reliable, objective, useful, and complete. Developing criteria that satisfy these requirements 

should be done during the planning stage. A question is how to present the criteria so that the reader 

understands that these requirements have been met. 

According to ISSAI 3100:13 the source of audit criteria should be possible to identify. This strengthens 

the legitimacy of the criteria as well as the whole report as it enables the reader to assess the 

legitimacy and relevance of used criteria.  

The source may be presented in a footnote or by referring to the source in the text. Usually it will be 

necessary with a footnote anyway, as a detailed reference to the source of the criteria is necessary. 

Footnote references should include reference to the title of the document, year issued and the page 

or paragraph number. Only stating a general title as "Budget 2010" makes it difficult for the reader to 

trust and verify the source. 

When more than one source of audit criteria is used for the same audit question or sub-question, it is 

usually best to present the criteria with the highest legitimacy first. Criteria based on parliamentary 

decisions, such as laws or budget approval, have the highest legitimacy. 

The description of the methodology should include information about what audit criteria that has 

been used. Usually it is sufficient to describe the principles or general sources of criteria as part of the 

methodology, while the detailed criteria as such are described in other parts of the report. Overall 

parliamentary decisions or general expectations on the audited entity may be described already in 
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the introduction. Sometimes such overall statements may be used as criteria, even if it normally is 

necessary to make them more operational, possibly by using other sources. More common is that it 

is suitable to present audit criteria in the chapter describing the audit area, as the purpose of this 

chapter is to explain how the systems and processed are supposed to work. At the same time it is 

usually difficult to clearly present findings without at least a reference to the criteria. 

Example of presentation of audit criteria 

The main purpose of the Medical Stores is to procure, store, and supply quality assured and affordable 

medicines, medical equipment and medical supplies to all public health facilities. It should ensure continuous, 

uninterrupted and adequate supply of approved quality and affordable medicines and other medical supplies 

to public and other approved health facilities.
 
To achieve this, the Medical Stores is expected to ensure: 

 constant supply of drugs and medical supplies to client institutions 

 effective quality control and monitoring of the supply chain management operations 

 effective and transparent procurement management systems 

 effective financial and administrative systems 

 effective operations management and integration of service delivery within the Medical Stores 

 effective technology framework for all NMS processes and procedures 

 adequate human capacity for undertaking procurement, financial management and administration, and 
general operations management 

Procurements should follow regulations as prescribed in the Procurement Act. Key requirements here are 
related to an open and documented tender process, including a systematic evaluation of all bidders.  

Good warehouse management is defined by Treasury Instructions
1
 and general standards for good record 

management. Controlling Officers (CO) must ensure that an efficient system exists within their Ministries for 
the control of stores and equipment. The records supporting stock and their movement should be relevant, 
sufficient, complete and reliable. There should be a systematic filing system of documents and information 
relating to stores to enable easy access for inspection. 

As a CO, the director of the Medical Stores is responsible for ensuring that all expenditure is incurred with due 
regard to economy, efficiency and effectiveness and the avoidance of waste. He/she is also responsible to take 
all necessary precautions to safeguard public resources. The CO must ensure that an effective system of 
internal control is developed and maintained.

2
 Through the technical supervision, the Ministry of Health is 

expected to monitor the internal control and economy, efficiency and effectiveness of the operations. 

COSO
3
 has developed an internationally recognised framework for internal control. Internal control is broadly 

defined as a process, effected by an entity's board of directors, management and other personnel, designed to 
provide reasonable assurance regarding the achievement of objectives in the following categories: 

 Effectiveness and efficiency of operations 

 Reliability of financial reporting 

 Compliance with applicable laws and regulations 
1
 Treasury Instructions for Stores, issued 2008, page no 3. 

2
 Public Finance Management Act, section 10 

3
“COSO” stands for “The Committee of Sponsoring Organisations of the Treadway Commission”. 

(www.coso.org/publications/executive_summary_integrated_framework). 

 

3.4 Presentation of findings 

The presentation of the findings in the report as a whole should usually consist of four elements: 

1. Audit criteria - how it should be 

2. The actual conditions based on evidence - how it is 

http://www.coso.org/publications/executive_summary_integrated_framework
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3. Causes - why it is 

4. Consequences - the effects of the difference between criteria and present condition 

The findings should focus on the performance of the audited entity and the root causes to the 

observed problems. The conditions the audited faces need to be considered, for example the 

availability of resources, in order to be able to assess the performance appropriately. However, the 

focus of performance audit should be on how the available resources have been used. If the available 

resources not are sufficient to reach objectives there are at least two alternatives, to change the 

objectives or increase the resources. 

The audit criteria are the norms and standards are used as a basis for assessing the economy, 

efficiency or effectiveness demonstrated by the government administration. The auditors develop 

findings by comparing evidence on the actual conditions to audit criteria. The evidence must be 

based on relevant facts that are comprehensive and correctly presented. The data has to be 

presented in a compiled form and analysed in the findings chapter. Interview statements, especially 

from management of the audited entity, have to be corroborated with other evidence and analysed 

critically to avoid biased audit evidence. 

The report has to have a logical flow presenting findings in an order making it easy for the reader to 
understand the different parts of the report, and how they can be linked. The audit question, the 
content in the problem tree, question tree or design matrix can often be used as headings in the 
presentation of the findings.  

Findings are the discrepancy between the conditions as verified by audit evidence and the criteria 

used. In a problem oriented audit it is usually appropriate to start by presenting the evidence for the 

problem as such, before moving on to findings addressing the causes to the problem. When such 

logic exists, it is important explain the links between different findings to the reader. Depending on 

the report structure, and how thorough the analysis is, it is sometimes appropriate to present 

additional causes and consequences as part of a particular finding.  

An example from SAI Namibia is shown below, where the audit problem was lack of transport for the 

police. One of the main issues is the high maintenance cost. So if the findings chapter is chapter 4, 

then High maintenance will be 4.1. Delays in maintenance will be 4.1.1. Service to commercial 

garages will be 4.1.2. Continuous repair for vehicles with high mileage will be 4.1.3.Sub-issues will be 

presented at lower levels i.e. 4.1.1, 4.1.2 and 4.1.3. 
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Example: Allocation of police vehicles to regions, stations and units in Namibia 

The auditors discovered that vehicles are allocated by the Head Office to regions, where the regional 

commanders allocate the vehicles further to different stations and units in their regions. Interviews conducted 

with personnel in the Department of Police revealed that there is a general dissatisfaction in the way that 

vehicles are being allocated. This can be attributed to the fact that the Head Office does not consider allocating 

vehicles according to requests from the regions. Section f1 (a) of the store manual that “gives the power solely 

to the Chief Transport Services for the acquisition, planning, management, allocation and maintenance of 

transport” for the Police. 

The audit revealed that there is no standard for the allocation of police vehicles to regions or stations. Vehicles 

are allocated according to resources available to the Police Department, without properly taking regional 

requests into consideration. Furthermore the auditors concluded that the regions do not always receive 

vehicles as requested from the Head Office due to a lack of financial resources. According to interviews with 

staff at the Head Office limited financial resources to acquire materials as well as assets like vehicles were cited 

as reasons for not attending to regional needs as requested. 

At the time of the audit it was found that there are proposed criteria for vehicle allocation for the Department 

to address the disparities that currently exist among regions and stations. However, at the time of the audit, 

this was still a proposal that was made by the fleet management committee meeting that took place during 

19/05/2004, due to the lack of vehicle allocation standards. Officials in the Department believe that if this 

proposal is approved and implemented, vehicles will be more equally distributed. They will then be allocated 

according to the number of stations in the regions as well as the size of the stations. 

Table Combined regional vehicle statistics for the period 2000-2003 financial years 

Region Number of 

vehicles 

Serviceable/running Unserviceable 

Total 2x4s 4x4s Total 2x4s 4x4s 

Khomas  240 168 123 45 72 60 12 

Okavango
1
 73 48 36 12 25 14 11 

Kunene
2
 61 48 19 29 13 6 7 

Omusati 12 11 8 3 1 - 1 

Hardap 63 61 35 26 2 1 1 

1
 According to documents, the Okavango region has 73 vehicles allocated to it plus a borrowed vehicle from the 

Grootfontein police station in the Otjikoto region bringing the number of vehicles in the region to 74.  
2
 A document on vehicle statistics for the Kunene region reveals that 64 vehicles are on hand. However, from 

these 64, two are generators and one a caravan reducing the number of vehicles to 61. 

The above table indicates the statistics of vehicles allocated to the various regions. See annexure 4 for the 

number of vehicles needed per region and for the financial implication of vehicles needed in various regions. 

The majority of vehicles needed are 2x4 and 4x4. 

According to the Department of Police records are not kept of how many cases were unattended to due to a 
shortage of vehicles. They further state that a lack of enough vehicles is part of the constraints the investigation 
officers have to cope with, and it hampers effective policing tremendously. (See Annexure 5.) 

Source: Lack Transport (Police Vehicles), Office of the Auditor-General of Namibia, 2003. 
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Usually the causes and effects of performance audit problems addressed in reports are complex. 

Audit criteria are needed to establish that the audit problem exist – one of the findings in the report. 

The other findings will be causes, and possibly some consequences of the audit problem. In the 

methodology presented by AFROSAI-E audit criteria are used for all findings presented in the report, 

also when the findings are linked to the Audit problem in a cause-effect relationship. This means 

that: 

 One issue called "finding" may be the cause of another observation called "finding"; and 

 One issue called "finding" may be caused by several other issues called "findings" and is 

therefore the consequence of all these "findings".  

The auditors need to investigate, collect evidence and make proper analysis to verify causes to the 

audit problem. Auditors sometimes put overreliance on explanations to observed problems provided 

through interviews with the management of the audited entity. Such interview information is not 

sufficient as audit evidence. While the explanations by management should be considered they are 

more often than not correct or comprehensive as explanations to the problems. The auditors need to 

arrive at their own understanding of the problems and its causes by searching for different types of 

evidence. The audit team also needs to identify determine which causes that could have been 

prevented (actionable causes). These are the factors to address with recommendations. 

If possible the team should try to identify the effects of the observed problems. In identifying the 

effects, the actual situation (where the criteria are not met) can also be compared with the ideal 

situation where the criteria would have been met. The effects could be noted either as what has 

already occurred or, based on logical reasoning, as the likely future impact. The nature of the findings 

determines whether the audit team can present actual or potential effects. In general, auditors 

should be careful in elaborating on effects without evidence, as the risk is that the effects are 

overestimated. 

3.5 Presenting the responses of the audited entity 

The auditors must assess the responses of the audited entity. If there are basic factual and principle 
disagreements of importance, the reader should be informed about it. 

Comments from the audited entity related to individual findings may be incorporated as part of the 

description and analysis of the finding or presented after the presentation of the respective findings 

or even in a separate section. A response which covers several findings and how they are related, are 

best presented as part of or after the conclusion.  

3.6 Conclusions 

The conclusions should focus on the performance of the audited entity, i.e. the economy, efficiency 

and effectiveness with which the operations has been carried out. The availability of resources may 

need to be considered, but should not be in focus of performance audits – the focus is on how the 

available resources have been used. Non-compliance with rules and regulations may form part of the 

conclusions, provided that compliance what lead to better performance. 

The conclusions must be linked to audit objectives and the findings answering the audit questions. 

They should flow logically from the findings, their causes and their effects. All analytical steps taken 

beyond the findings should be clearly explained and justified. Conclusions go beyond merely 
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restating the findings. Whereas the audit findings are identified by comparing what should be 

(assessment criteria) to what was actually happening (conditions based on audit evidence), the 

conclusions reflect the SAIs summary and opinions based on these findings. This is why findings are 

usually expressed in the past tense and conclusions in the present tense. Conclusions might include 

identifying a general topic or a certain pattern in the findings. An underlying problem that explains 

the findings may also be identified.  

Conclusions should be clearly separated from findings. The main conclusions should be easy to 

identify, and focus on the major issues of the report. The conclusion should summarise the verified 

problem and the causes to shortcoming in terms of economy, efficiency or effectiveness. Try to avoid 

just repeating the findings. Usually it is possible to summarise the findings on a higher level and when 

appropriate describe the wider implications of them. Ideally the conclusion should bring together the 

whole audit and be expressed in relation to the audit objective. This will often mean that the most 

important political goals or other criteria are also brought into the picture. 

The conclusion should clarify and add meaning to specific findings in the report, especially related to 

deficiencies in economy, efficiency and/or effectiveness. To deal successfully with how findings are 

related and the complexity of the linkages problems – causes - effects, it is recommended that the 

conclusions are written as a narrative text (not only a list of issues) without too many headings. The 

problem verified in the audit, linked to the causes of the problem (and possibly effects) and the 

responsibilities of the audited entity to rectify the situation, should be made clear in the conclusions. 

Audit conclusions reflect the view of the SAI deduced from the findings. A conclusion is the auditor’s 
view or opinion formed after considering the findings. The performance auditor is not expected to 
provide an overall opinion on the achievement of economy, efficiency and effectiveness by an 
audited entity in the same way as the opinion on financial statements. A report is normally 
addressing specific areas of an entity's activities. The auditor should provide a report which describes 
the circumstances and arrives at a specific conclusion rather than a standardised statement.  

To exemplify the above, we have used the example from the Police in Namibia in the box below 

Example – Conclusions in the report on the Police in Namibia 

Based on the facts presented in the findings chapter, the auditors concluded that there is a lack of transport in 

the Police Department and this is the main reason for the inefficiency in the Police Department carrying out its 

activities. More specific conclusions were made as follows: 

1. Based on the auditors’ findings, the auditors concluded that transport facilities have a major impact on the 
effectiveness of the Police Department in rendering their services to the public. The auditors further 
concluded that without suitable vehicles the police force will not operate effectively. If police stations do 
not have vehicles it is difficult for them to perform their duties. 

2. The procedures used for the calculation of funds to be allocated on a monthly basis to regions and stations 
as well as NAMPOL Medium Workshop is impractical as it does not consider the size, model, make, etc. of 
vehicles and the difference in their maintenance costs.  It results therein that allocation of funds are not 
sufficient per vehicle per month. The repair process of police vehicles which could have been repaired 
easily, is delayed, which leads to a lack of transport within the Department of Police to combat crime. 

3. It was concluded that the store manual which is the regulatory instrument for the acquisition and 
management of transport facilities is outdated and not fully implemented resulting in the fact that the 
acquisition and management of the transport facilities is not effective. 

Source: Lack Transport (Police Vehicles), Office of the Auditor-General of Namibia, 2003. 



 

AFROSAI-E Report Writing  Performance Audit Guideline 29 

 

3.7 Recommendations 

A rule of thumb to get a logical flow between findings, conclusions and recommendations is to think 

about conclusions and recommendations already when you are designing the study. Good 

recommendations should answer these questions: 

 What needs to be done? 

 Why does it need to be done? 

 Where does it need to be done? 

 When does it need to be done? 

 How is it to be done? 

 Who is to do it? 

The recommendations should address the causes to the problems identified in the audit. In the 
whole audit the auditors need to take into account the realities and restrictions faced by the 
management of the audited entity. One of the most important criteria in developing 
recommendations is the practicality of the recommendations in the setting where the audited entity 
operates. A useful approach to ensuring practical and useful recommendations is to consider possible 
recommendations at the same time as collecting evidence for findings and conclusions. In principle 
all interviewees and stakeholders can be asked for their opinion on what measures that are needed 
to improve performance. This can give the auditors different perspectives on what needs to be done, 
and be highly useful in developing the auditors’ recommendations – taking the views of different 
actors into consideration. It is also a good idea to discuss the recommendations with top 
management of the audited entity before they are finalised. 

The purpose of putting forward recommendations and suggestions for corrective measures is to 
influence the government administration to implement actions that will contribute to better and 
more efficient use of public resources. By means of the recommendations included in the report, the 
office of the Auditor General identifies and draws attention to areas that require correction, 
improvement and greater efficiency, and puts forward practical proposals, where applicable, that will 
help audited entity to enhance effectiveness with regard to fulfilling intentions and attaining 
performance goals. 

Recommendations should address the entity responsible to take action. This also means that 
different recommendations should be clearly addressed and adjusted to the needs of the entity 
expected to take action. In general the auditors should avoid making a large number of 
recommendations. It is usually possible to cluster the recommendations in a fewer groups, adding a 
narrative on what needs to be done. In particular recommendations the PAC are expected to 
consider need s to be adjusted to the level Parliamentarians work on. 

Performance auditors should seek to provide constructive operational or structural 
recommendations, which are likely to significantly contribute to addressing the weaknesses or 
problems identified by the audit. In order to contribute to improvement the recommendations need 
to address causes to problems rather than the symptoms. In the recommendation it should be clear 
what the purpose of the recommendations are, and in what way it is expected to lead to 
improvements. The auditors should mainly address what should be done rather than how. On the 
other hand the recommendations must be specific enough to be convincing in that the observed 
problems can be solved or reduced as well as to give the responsible entity ideas or guidance for how 
the auditors believe this can be done. One technique for doing in this is to formulate the 
recommendation on a rather high level about “what to do”, while the methods that can be used to 
achieve this is discussed without being prescriptive. The responsible management should be 
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entrusted to make the judgement of what specific measures to take when carrying out the 
improvements. 

Some examples on recommendations are presented in three boxes below. 

Examples of recommendations from the report on medical waste management in Zambia 

 Government must develop a comprehensive waste management policy which should provide direction to 

all key medical waste managers on how waste should be managed. 

 All HCFs must ensure that workers handling medical waste are properly protected by providing them with 

appropriate protective clothing and equipment. 

 The Ministry of Health should coordinate a colour coding and labelling system and ensure uniformity of the 

coding system as required by World Health Organisation 

Source: Report of the Auditor General on Medical Waste Management in Zambia 2008. 

 

Examples of recommendations from the report on referral system at the Ministry of Health and Social 
Services in Namibia 

 The Ministry should come up with criteria for resource allocation according to the roles and classifications 

of the different health facilities but also take into consideration the catchment population served by a 

particular health facility. 

 Finalise the restructuring of the staff establishment to address the on-going shortage of staff within the 

Ministry and also come up with a criteria to sufficiently allocate staff among the different level heath 

facilities so as to be responsive to the demand of patients and accommodate new heath programs. 

 The MOHSS should determine whether or not it is a viable option to convert OPDs at district hospitals into 

clinics. 

Source: Follow-up report of the Auditor-General on performance audit study on the Ministry of Health and 
Social Services – Referral system for the financial years 2008, 2009 and 2010 

 

Examples of recommendations from the report on the supply of teaching and learning materials programme 
in Malawi 

 The Ministry of Education, Science and Technology should provide the Supplies Unit Directorate with 

adequate trucks to be used for distribution for the efficiency of the programme. 

 The Finance Section in the Ministry and the Supplies Unit Directorate must ensure that there are efficient 

procedures for funding the distribution of materials. This means ensuring that there are sufficient 

allowances for staff and fuel should be available on time. 

 The Supplies Unit Directorate should ensure that materials are distributed in the beginning of the school 

year when all roads are accessible. 

 To ensure transparency, the Special Procurement Unit should have documentation of any amendments 

and variation to contracts with suppliers. All amendments must also be communicated to the Supplies Unit 

head office for reference. 

Source: Performance audit report on the supply of teaching and learning materials programme in the Ministry 

of Education, Science and Technology. Malawi 2011. 
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Some characteristics of good recommendations are that they: 

 Flow logically from the findings and conclusions, referring only to matters addressed in the 

report; 

 Are directed at those who have authority and responsibility to act; 

 Are stated positively and constructively; 

 State what actions need to be taken to improve economy, efficiency and/or effectiveness; and 

 Indicate alternative solutions when more than one course of action can be used to address the 

problem. 
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4. General advise on presentation and language 

4.1 The structure of a report 

A good report should have a clear and logically linked structure guiding the reader to key messages. 
There will often be many different ways of structuring an audit report. For instance, to simplify the 
report, one can eliminate having findings, conclusions and recommendation chapters on their own. 
Instead each finding could be accompanied by conclusions and recommendations. 

Here are some examples of structuring the findings: 

 By audit question, issue or theme. Here different sections of the report are directed at a 

particular theme or issue arising from an audit (e.g. for a procurement report the themes could 

be “Minimising the cost of letting contracts”; “Maintaining an effective supplier base”; 

“Obtaining best value from procurement”; etc) 

 By process or system. Here the report would be structured to follow the logical process or system 

reviewed. (Again using a procurement example, different sections of the report could focus on 

“Establishing procurement specifications”, “Selecting suppliers”, “Opening and evaluating bids”; 

“Issuing contracts and contract amendments”; “Validating goods and services received”; etc) 

 By organisation. Here the report would be structured around the different organisations 

examined during a review.  

 By geographic location. Here the report would be structured around the different geographical 

location of entities or activities examined (e.g. “Procurement in Central Government”; 

“Procurement in local government”; etc). 

General advice for structuring information in reports includes: 

 Group related information together; 

 Order the material in a logical sequence; 

 Place more important information before less important information. Put the information most 

important to the reader at the beginning; 

 Summarise complicated topics before presenting details. Consider whether the detail should be 

part of the report or the annexure; 

 Introduce and summarize what follows, including the conclusion, at the beginning of the 

document and major sections. As performance reports usually are long, explain how the 

document is organised; 

 Chapters should be short. Longer chapters must be subdivided; 

 Use descriptive headings and subheadings with caution, to prevent breaking the flow of the 

information; and 

 Organise the document to minimise cross-references that can confuse the reader. 

4.2 Past or present tense? 

In principle, things must have happened to be audited. Most of the data collected in an audit will 

refer to a date in the past. This is a reason why findings often may be stated in the past tense. In 

general, however, the observations in the audit should be brought up to date by inquiring and 

possibly collect additional data on what may have changed since the time the most of the data refer 
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to. The audit may for example present statistics that are one year old, as this is the latest available. In 

terms of the main observations and findings, however, the auditors need to consider what have or 

may have changed since then to avoid reporting obsolete information. The “conclusions” should 

state the situation at the time of finalising the report. Consequently it is appropriate to use the 

present tense. Recommendations should be written either as a request using the conditional mood 

or as a demand using the imperative mood. 

Table 1: Use of tense for findings, conclusions and recommendations 

 Past tense 

Yesterday 

Present tense 

Today 

Conditional or imperative mood 

Tomorrow 

Findings X (X)  

Conclusions  X  

Recommendations   X 

4.3 Using short and understandable sentences to explain 

The general concept is to write short sentences with an average of 15-20 words in each. Be specific 

and accurate: "The Department have commissioned a study on … which will report in three month's 

time" and not: "The Department are looking into the matter…"Do not overuse phases like: "We note 

that". Use verbs and not nouns to describe activities. Be aware that too repeated use of passive voice 

makes the report seem vague and impersonal. One must bear in mind that the text must be 

understandable, have a logical flow and that the different parts must be linked together guiding the 

reader through a coherent report with a coherent text within each section and sub-section. General 

advice on paragraph construction includes the following: 

 Write short paragraphs. Limit your paragraphs to one topic or idea; 

 Start each paragraph with a clear statement or main message to give a general idea about the 

content of the paragraph. The sentence is expected to guide the reader and to help him/her to 

get a perspective on what is coming and how to put it in perspective;’ 

 Develop the information through a logical sequence of sentences; 

 Link different paragraphs to each other by using transitional words7; and 

 Use examples to explain and to eliminate text. 

Hints & Tips 

If you are having difficulty expressing something say it out loud as if you were explaining this to one 

person and then write down what you have just said. It will usually be 90% of what you need to 

write. 

4.4 Formulating sentences 

The writer has to be critical to all sentences that are written down, and has to examine the inner 

logic of sentences and paragraphs. Reports are being made easy to understand by using moderate 

and active language. If possible, avoid using technical language. When technical language or jargon 

cannot be avoided, make sure to explain the used terms properly in a glossary.  

                                                 
7
 See http://www.smart-words.org/transition-words.html for examples 

http://www.smart-words.org/transition-words.html
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Sentences are the building blocks for all reports. General advice for sentence formation and language 

use in English includes the following: 

 Write short sentences. Set your average length to about 15-20 words. Find ways to split long 

sentences; 

 Use the active tense (the school's survey shows that…) rather than the passive tense (the results 

from the school survey seems to indicate that …). A passive construction is longer and raises the 

question of who is the subject providing the views; 

 Place the main idea before exceptions and conditions and avoid beginning sentences with 

conditional clauses. (E.g. replace “with the exception of x, the report is good” with “the report is 

good except for x.”); 

 Write in a neutral tone - avoid language that generates defensiveness and opposition; 

 Write recommendations positively, what the entity needs to do; 

 Avoid double negations; 

 Select words carefully to avoid ambiguities. Connect modifying words to the words they modify; 

and 

 Use proper grammar and punctuation. These are the practices of language and facilitate effective 

communication. Some readers can be really offended by poor grammar and punctuation. And a 

poorly written report can unintentionally cast doubt on the validity of the audit findings. 

Hints & Tips  

Remember, there is no “official language” that is somehow different from the oral language we use 

every day. Write so that basically anyone can understand the report. 

4.5 Using words 

All reports involve choices about the words and phrases used to convey the message. General advice 

on the wording of reports includes the following: 

 Use words that are short, simple, common, and familiar. But do not do so at the expense of 

accuracy; 

 Avoid legal, bureaucratic, and technical jargon. Avoid unfamiliar acronyms and abbreviations. 

Explain all abbreviations when first used and include a list of abbreviations where necessary. 

Avoid using many acronyms, as it makes the text difficult to read; 

 Avoid colloquial words or phrases; 

 Omit unnecessary words. Reformulate wordy phrases; 

 Use defined terms sparingly. Include a glossary when using more than 2-3 defined terms; and  

 Use technical terms only where you have to use them. Explain them if your audience is not 

familiar with them. 

4.6 Presenting tables, figures and photos in audit reports 

Tables, figures (graphs, flow-charts, pictures, maps and diagrams) and photos visualise the 

information presented. Such techniques break the monotony of the text and are also more suitable 
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for presentation of some types of information. Tables, figures and photos should be vivid 

(distinctive), easily understood, meaningful and self-explanatory.8 

Photos are good to use when the purpose is to show for example the condition of a building or a 

road. The saying is that ‘a photo says more than a thousand words’. It is important to explain and 

interpret graphics, but be aware of the risk of explaining too much of the table, figure or photo. It the 

texts and graphics are showing exactly the same thing, it means that there are un-necessary 

repetition of information. Keep figures and tables simple – they should illustrate one idea- or a 

finding and the reader should be able to grasp the information quickly. Specifically: 

 Avoid using too many words in tables and figures and avoid the temptation to put in lots of 

arrows and comment boxes. Use the text around the graph to explain its importance; 

 Place the graph/table on the most appropriate page of the report; 

 Give the graph/table a clear title, which explains the contents of the graph; 

 Always include below the graph/table (or in the title if this is possible) a short statement, which 

explains what the graph is telling the reader; 

 Use tables only when it emphasises the issues being raised in the audit report; and 

 Round all numbers in tables (and the report in general) to the highest appropriate level. It is 

easier to remember rounded numbers. 

The following figure is an example of a good, clear and informative figure from a performance audit 

report on the management of solid waste from the SAI of Lesotho in 2011. The figure contains 

information on the amount of dissolved solids in drinking water. It shows the exact trend in 

deteriorating water quality in relation to the total amount of dissolved solids. The figure also 

compares the results for each of the three years directly with the standard for the total amount of 

dissolved waste in the Republic of South Africa (RSA). 

 

The next example is from a draft report on deployment of teachers in Zambia in 2012. The audit 

team conducted a survey among close 87 basic schools. The results from the survey showed that 

more than half of the schools (56%) had a shortfall of teachers compared to a norm of 40-1 pupil per 

                                                 
8
 Can you see the wood for the trees? A guide to making clear simple graphics. Vfm development. 
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teacher. There was also a slight tendency that the relatively large schools more often had a shortfall 

of teachers than the smaller schools.11 

Figure 1: Pupil Teacher Ratio (PTR) at the Basic Schools (N=87)9 

 

In total, 62 % of the pupils are enrolled at schools with fewer teachers than the norm, while 38 % of 

the pupils are enrolled at schools with a higher number of teachers than the norm.  

The figure contains a lot of information, which may make it more difficult to fully understand by 

some readers. Often, but not always, it is a good idea to try to make the figures simple. Maybe two 

simple figures can be used rather than one more complicated. On the other hand it should be 

avoided to use too many tables and figures in the report. 

When commenting on tables, figures and photos the text should extract the most important 

information – the message – the auditors want the reader to understand from the presentation. 

Some additional information can be provided in footnotes, as in the example above. 

Numbers in tables should be rounded to a reasonable level, for instance, 1,453,000 Shillings rather 

than 1,452,969.71 Shillings. When interpreting the numbers in the main text, the presentation can be 

even less precise. It is usually better to write almost 940 thousand USD, rather than 939,376 USD. 

Write almost one third of the population rather than 31 per cent, and put the actual figure in 

brackets if they need to be presented. An alternative is also to use words like most, a minor part etc. 

and then put the figures in brackets. 

  

                                                 
9
 Each school is represented with a bar in the diagram. In total there are more than 100 000 pupils enrolled at 

the 87 schools in the sample. The wider the bar, the more pupils are enrolled at the same school, ranging from 
191 pupils to 5268 pupils. 
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Appendix 1 Functions in MS word which makes the writing process 

efficient 

Especially four functions in MS word can make the writing process efficient and help the team to 

produce a high quality report: 

 Use of headline styles to ensure consistent headlines, easy navigation in the document, an 

automatic synopsis and a table of contents; 

 Track changes and insertion of comments for easy communication about reviewing; 

 Spell check; and 

 Automatic numbering of captions to tables, pictures and graphs and automatic cross-referencing 

in the text to these captions. 

Saving word-documents as a PDF-file is also a useful function. It is advisable to save the draft report 

sent to the audited entity as a PDF, to ensure it is not re-edited by a mistake. The finally approved 

version of the report must be saved as a PDF. 

How these functions can be applied in different word processing software is usually well explained 

through the help function in the programme or at the webpage of the programme, such as the site of 

Microsoft Office. Below follows some brief explanations of how the functions mentioned above can 

be applied in MS Word 2010.10 

Use of styles for headings 

A style is a set of formatting characteristics, such as font name, size, colour, paragraph alignment and 

spacing. There is no need to take three steps to format each of your heading separately as 16-point, 

bold using a particular font. You can achieve the same result by formatting the style for headings on 

different levels, and apply for example the "Heading 1" style in one step. For each text you want to 

have as a heading in your document, you just click in the heading and then click "Heading 1" (or 

"Heading 2", etc) in the gallery of styles. Right-click on the icon for the style Heading 1 in the gallery 

and select “Modify” to edit it. If you tick the box 

“Automatic update” in the menu for editing, all 

headlines defined as "Heading 1" will be 

updated. If you include automatic numbering of 

heading styles the numbering will be adjusted if you insert new sections or restructure the report. 

When styles are applied on headlines in the text, you can easily see the synopsis of the report, 

navigate in the document and automatically get a table of contents: 

 Use the Navigation Pane (can be found under the “View” tab in MS Word 2010). The headings 

view in the Navigation Pane provides a good visual representation of the structure of your 

document by displaying its headings. You can quickly navigate to a particular heading in your 

document by clicking on the corresponding heading in the Navigation Pane.  

 Insert an automatic table of contents in the "References" tab. 

                                                 
10

 Sources: www.mswordhelp.com and www.word-2010.com 

http://www.mswordhelp.com/
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 Outline view (selected in the "View" tab) helps you see and focus on the synopsis and structure 

of the report. In Outline view you can create or edit headings, adjust heading levels, and 

rearrange the content. 

 Automatic table of contents (TOC): When your document is ready for a TOC be careful where you 

position your cursor. The TOC will be inserted where the cursor is, not at the start of the 

document. Insert the TOC through the "References" tab. Headlines in the report may be 

changed. Update the TOC by right-clicking on it and select Update all. 

Track changes and comments 

The "Review" tab contains a lot of useful reviewing functions, including 

the Track changes button and the insert comments. When you click on 

the Track changes, it is activated. You can tell Word what changes to 

track, for instance insertions, deletions and changed lines. Click the 

bottom half of the Track Changes button and select Change Tracking 

Options. 

The fact that Word is tracking changes doesn’t necessarily mean that 

you have to see those changes. You will need to use the Display For 

Review selector in the Tracking group to determine what you see in 

the document. The ones that include “Show Markup” display the 

tracked changes. When it’s time to print your document, you have 

several options relating to whether or not tracked changes get printed 

too. Use the display for review to select what to print or specify in the Print Settings (after selecting 

"Print" in the File menu), whether you want to print the document, print the document and tracked 

changes, or print only a list of tracked changes. 

 

You can insert a comment inside balloons that appear in the document 

margins. To type a comment select the text or item that you want to 

comment on, or click at the end of the text. On the Review tab, in the 

Comments group, click New Comment. Then type the comment text in the 

comment balloon or in the Reviewing Pane. 

Once your document has been reviewed and passed back to you, the next logical step is for you to 

“process” the changes tracked and the comments inserted. There are only two actions you can 

perform on a tracked change: accept it or reject it. Both actions remove the indications that the 

document has been changed. As you might expect, accepting a change incorporates it into your 

document, whereas rejecting it simply ignores it and removes it without a trace from the document. 

Comments can be deleted once dealt with (right-click on the comment and select “Delete”), or 

replied to by clicking inside them and inserting a new comment. 

javascript:AppendPopup(this,'833516854_2')
http://www.word-2010.com/wp-content/uploads/2012/06/final-show-markup.jpg
http://www.word-2010.com/wp-content/uploads/2012/06/change-tracking-options.gif
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Check spelling and grammar 

After you click Spelling & Grammar in the Review tab, you can fix each error 

that Word finds in different ways. A box will appear for you to see the spelling 

and grammar choices. 

Automatic caption of tables, pictures and graphs 

A caption is a numbered label, such as "Figure 1", that you can add to a figure, a table, an equation, 

or another object. To insert it select the object (table, equation, figure, or another object) that you 

want to add a caption to. Then on the References tab, in the Captions group, click Insert Caption. 

Select the label that best describes the object, such as a picture or equation. Type any text, including 

punctuation, which you want to appear after the label. When captions are defined like this, you can 

also insert automatic cross-referencing in the text to these captions, also in the References tab. 

  



 

AFROSAI-E Report Writing  Performance Audit Guideline 40 

 

References  

AFROSAI-E Performance Audit Template Manual, 2010, Chapters 4.14, 4.15, 4.16, 4.17, 4.18 and 5 

AFROSAI-E Quality Assurance Handbook, 2012, Chapter 6 

ISSAI 40 Quality control for SAIs, INTOSAI, 2010 

ISSAI 300, Exposure Draft, Fundamental principles for performance audit, INTOSAI Audit Standards 
Committee, 2012 

ISSAI 3000 Standards and guidelines for performance auditing based on INTOSAI’s Auditing Standards 
and practical experience, INTOSAI, 2004 

ISSAI 3100 Performance Audit Guidelines – Key Principles, INTOSAI, 2010 

Making Performance Audit reports Reader-friendly, INTOSAI Performance Audit Subcommittee ( 
PAS),  

Reports and presentations from the Supreme Audit Institutions of Namibia, Malawi, Zambia and 
Ghana 

Reports that counts. A Guide to Drafting Convincing High Quality PAC Reports, National Audit Office 
of U.K 

VFM development. Can you see the wood for the threes? A guide to making clear simple graphics, 
National Audit Office of U.K 

Writing smart recommendations, National Audit Office of U.K 

 


